March 15, 2018

    FY18 Traditional School District FTE detail to SFPR reconciliation
			Includes CTE Detail reconciliation
			Includes In-Seat FTE by Grade Level
[bookmark: _GoBack]There is not a required way to use the FTE detail report.  This is one suggestion on how to reconcile it to your SFPR. Please use as best meets your need You can also now reconcile your BDD adjustment and VE services adjustment if you have them.  Keep in mind this is still a work in progress. Some of your differences may be attributed to rounding.  Rounding issues will be more prevalent in districts that have greater mobility with their students.  Lastly there will be timing issues.  Your FTE detail report may be more current than your SFPR.  For best results try to run an FTE detail report two Mondays prior to the SFPR settlement you are trying to reconcile.
Phase One:
This document is a work in progress.  When updates occur to the FTE Detail these directions will change.  This method can work in any size district in Ohio. 

Open your foundation funding report on the ODE website.  Choose the period you want to reconcile such as Jan #2.  Choose your district and click on five reports; 1) School Finance payment report Detail 2) Open Enrollment 3) Scholarship Deduction 4) Community School Deduction Summary 5) Preschool Special Education. 
Open your reconciliation workbook.  It should open to the SFPR tab, if not, click on the SFPR tab. You may want to hide columns D through W, and column Y to make entering the base data easier. In cell B4 enter your IRN number. Make sure your District name shows up in cell C4!!  Go to cell X4 and put the Month and #1 or #2 for the period you are reconciling. Enter the FTE’s from the ODE Foundation “Detail” report for cells X8 to X11, X13 to X18, X20 to X24, X26 to X28, X30 and X31, X33 to X39, and X41.  Enter the Preschool category 1 through 6 FTE’s into X45 to X50 from the Foundation Preschool report.  
Go to the foundation funding report.  Copy the Community School Transfer Summary info into the Community School tab.  Copy into cell A1.  Click on Data, Text to Columns, choose fixed width and then go through the steps.  You may have to move the line separators around, especially if a STEM school is included. Sort the community schools by IRN number, “Smallest to Largest” sort order.  The end result should look like below:
[image: ]
Copy the first two columns with descriptions IRN and Community School into cell B55 and C55 on the SFPR tab.  Next copy the Student FTE data into column X of the SFPR tab.  You do not need any of the other information. If any Community School names have an asterisk that means they are a STEM school.  Place the info for those schools under STEM and delete from Community School. The row STEM begins on will depend on how many community schools you have.
[image: ]
Go back to the foundation funding report.  Copy the Open Enrollment Data into the reconciliation workbook tab OE.  Copy into cell A1 and do a text to column.  Click on Data, Text to Columns, choose fixed width and then go through the steps.  You may have to move the line separators around.  The end result should look like below:
[image: ]
Sort Column “Type”, “Z-A” sort order.  The CT’s will be at the bottom.  Add three empty rows between the bottom JVSD and the first CT code.  Copy the headings in row 1 to the row above the first CT data.
[image: ]
Next sort by “or RECEIVED”, “Smallest to Largest” sort order.  If you have NO positive numbers, you only have open enrolled out.  Insert three rows between the last negative number row and the first positive number row.  Copy the headings in row 1 down to the top of the positive number row.  Next sort column A (IRN) negative amounts and then sort Column A (IRN) positive amounts smallest to largest.  Next copy ALL of the negative IRNs in column A to column L.  Click on Data and choose “Remove Duplicates”.  Go through the steps, below you will see the “Before” and “After”:

[image: ]
A message box will pop and tell you “13 duplicate values found and removed; 8 unique values remain”. 
Obviously everyone will have different numbers of duplicate values and unique values.  
You will then copy the unique IRN values to column B into the first row reserved for Open Enrolled Out IRNs.   Column C in the first row will have a formula that will look up the name of the District that corresponds with the IRN.  You may have to copy that formula down as far as you need it.  
Go through the same steps for your positive amount IRNs.
Once they are sorted you can click on DATA, then subtotal the “open enroll out” FTE by IRN using the sum function and adding columns (1) FTE and (2) FTE.  Example below.
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The results should look like this.
[image: ]
You now need to enter the STUDENT FTE (first FTE column) into column X of the SFPR tab.  The easiest way to do this is by clicking on box 2 in the left hand corner next to column A and row 1.  This will give you a total for each IRN and this should make it easier to copy each IRN total by holding the control key down while you copy each individual cell over to the SFPR tab. [image: ]
When you reconcile Open Enrollment you have to be aware that the SFPR Open Enrollment report does not show the IRN for students attending a JVS, it shows the IRN of the pass through school.  It will show those FTEs like this; 
[image: ]
You will need to add the IRN numbers of the JVS to your spreadsheet in order to capture those students from the FTE Detail.  Put the IRN or IRNs of the JVS in the first row following your last traditional district IRN  in the open enrolled out section. Tab “IRN” includes all the IRN numbers for JVSDs for you.  The jointure Y students (IRN 48397) will show up under FTE Pattern Code OJVR in both lines a2 and a4.  Just like the RGJV students that are on line a4 they will not generate FTEs for special ed, disadvantaged youth or LEP.  The jointure N student (IRN 50252) will show up as OPID student on line a2.  They do not show up on line a4 or line a5.  .2 will go to the traditional school and .8 to the JVS.   
Next go through the same steps for “Open Enrollment In” students.  You do not need to add IRNs for JVS students in the Open Enrolled-In section.
The difference between the grand total you come up with and the “STUDENT FTE IN & OUT” on the SFPR will be the total CT’s you have either coming in or going out.  
The “Other Adjustments” is your special ed and vocational contract students.  Many of you will not even have this.  If you do, you will want to copy that data over into the “Other” tab just like you did with the community school and open enrollment data.  Next sort the data by the Status code and separate the SEs from the VECs.  Use the same procedures for subtotaling and bringing the data into the SFPR tab as you used for open enrollment.
On the SFPR tab of the reconciliation spreadsheet scroll down past the Special Ed-Other Out and Voed-Other Out.  You will find the BDD adjustment.  You will need to enter your state share index into the orange colored cell for category 1. The total should match your BDD adjustment on the “Other Adjustments” report if you have an adjustment.
In order to verify your VE Services Adjustment go to the Other tab in the reconciliation spreadsheet and enter your state share index into cell O2.
Phase Two:
Open your FTE Detail Report.  It should have one tab, and in that tab columns A to AL.  Stop. Was the last column AL. Columns were increased to AL on or around May 12, 2017. If the last column is not AL the reconciliation may not work.  It means that the detail report has changed and the reconciliation worksheet may need to be modified.

Place your cursor in cell B3, click on Sort and Filter and choose filter.  Click on the “VIEW” menu at the top of the spreadsheet.  Click on Freeze panes and choose “Freeze Top Row”.  Now scroll to the very last row of this worksheet.  Let’s say there are 4,140 rows.  Go to cell column Q row 4,142 and put in the following formula =subtotal(9,Q2:Q4140).  You can now filter any criteria you want and the number of Adj FTE’s for that criteria will subtotal.  You are now going to copy the FTE detail report into the “FTE Detail” tab in the reconciliation workbook.  Once you do that save the original FTE Detail report.  Best practice is saving it in an FTE detail report folder and name it the date that you created it.

The reconciliation workbook should have populated with the FTE details.  Variances between the FTE detail and the SFPR should be showing up in column Y.  You may be wondering why there are nineteen columns between D and V and some have numbers and some don’t.  If you hover your mouse over D5 there is a comment in that cell that will read “Regular/Other District and Regular JVSD”.  Each cell from D5 to V5 has a description of the type of student being captured in that column.  In most cases the columns with the highest FTE count will be RGJV, COMM (Community School FTE), and OPDD (Open Enrollment).  
Let’s look at the FTE detail report to see what column combinations created the FTEs.  Currently there are 38 columns from A to AL.  Of those 38, some combination of twelve of them are being used to populate the reconciliation spreadsheet.  Those twelve are:
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Each cell being calculated at the minimum looks at the IRN in cell B4 of the SFPR tab to find a match in column A, I, or S of the FTE Detail tab.  It then matches the Fund pattern code in row 5 of the SFPR to column M in the FTE Detail.  If there is a match it adds the FTE amount in Column Q of the FTE Detail.  
Some cell calculations will only include FTE INCL CODE FULL or PART in column AD of the FTE detail, some will include both.  If a cell calculation is only looking at FULL or PART only, it will reference column AD in the calculation.  Example; cell D8 (a3-Total ADM of the SFPR) includes both FULL and PART FTEs in order to capture both regular students and those going to the JVS.  Cell D10 (a5-Jointure JVS ADM) adds the AD reference, PART, to capture only those students going to the JVS.  The remaining cell calculations in column D use the FTE INCL CODE FULL because those lines of the SFPR do not include the JVS FTE component. The JVS receives the special ed, LEP, or economically disadvantaged funding for those students.
Your special education (SFPR b1 – b6), Limited English Proficient “LEP” SFPR d1 – d3), and economically disadvantaged (SFPR e10 and e12), funding lines look at columns AA (SPECED CAT CODE), AB (ECON DISADV FLAG), and AC (LEP CODE), in the FTE Detail tab respectively.  LEP lines also look at column AI (LEA Type) and only captures “B&M Comm” because Community e-schools do not receive LEP funding. 
This is a good time to remind you that in addition to not receiving LEP funding, e-schools do not receive K-3 literacy funding, targeted assistance, economically disadvantaged, or gifted intervention and coordinator funding. 
The e-school student “does” generate funding for gifted identification and capacity aid because those formulas use formula ADM from line a1.
“Open enrollment out” students require a FTE INCL CODE “FULL” to be used.  The “open enrollment in” students require a FTE INCL CODE “NONE”.
Pre-school funding includes fund pattern codes PSRD, PSEN, PSNR, PSOP, PSET, PBDD, PSON, PSIN, PSOT, and PSIT.  These are your special ed category students that get funded and a have a FTE INCL CODE of FULL.  Pre-school students coded with a PBDD are educated by the County Board of Disabilities.  You will have a deduct for these students in “Other Adjustments” coded “BDD Adjustment”.  A reconciliation for this is at the bottom.  Pre-school students coded with a NFRG do not have a special ed category and have a FTE INCL CODE of NONE. 
When reconciling community school students remember that STEM schools are included with Community Schools on the SFPR deduction summary report.  If you have a STEM school, it will have an asterisk next to the name.  
Special Ed co-op student are coded SPCO. SPCO students who are resident but are leaving the district are differentiated by having a FULL in the FTE INCL CODE.  Those students are funded normally.  The “Other Adjustments” report on the SFPR will show these students as a deduct with the funds going to the district that has the co-op program.  If your district has a co-op program, you will find the students coming to your district under SPCO with a FTE INCL CODE of NONE.  Under the SFPR “Other Adjustments” report these students will be added to your revenue. The adjustments will look like this:
[image: ]
The formula for a SPCO student is (ADM*base formula amount) + (ADM*Category weight).  The above calculations look like this based on FY17 base formula and weighted amounts:
[image: ]
Vocational contract students are coded as CTID, CTVC, and CTOP.  Students who are resident but are leaving the district are differentiated by having a FULL in the FTE INCL CODE.  Those students are funded normally.  The “Other Adjustments” report on the SFPR will show these students as a deduct with the funds going to the district that has the contract program.  If your district is accepting contract career tech students, you will find the students coming to your district under CTID, CTVC, and CTOP with a FTE INCL CODE of NONE.  Career tech students will also have a corresponding weight associated with those students and it will be calculated separately with a “CTA1” through “CTA5” code.
In the “Other Adjustments” you may also have a BDD ADJUSTMENT, this was mentioned earlier and is for your pre-school students attending a Board of Disabilities school.   
CTE Reconciliation
The CTE detail can be found in the data collector.  For FY18 the first manifest code was 2018L1S2R and if you have recently updated your information it is 2018L2FNL.  Best practice is saving the download separately from the reconciliation.  You will find 42 columns, A to AP, of data when you download this spreadsheet.  The number of rows will vary by District.  You will have a separate line for each career ed class a student takes.  
 Go to cell C2 and then choose the View menu.  Click on Freeze Panes.  Click on the first choice, Freeze Panes.  Next choose the Home menu, and click on Sort and Filter, then click filter.  Click on the filter drop down box in column P, local classroom code, and click sort “A to Z”.  You now have all the classes sequentially.  
Add another tab to the workbook.  Label it local classroom code.  Copy all of the data from column P, Local Classroom Code, into the tab you just named.  While the data is still highlighted go to the Data menu and click on Remove Duplicates.  Remove the duplicates. You will be left with a single entry for each class.   Most traditional districts won’t have more than 50 rows of classes, if you are a JVSD or a large urban you may have over 1,000 rows.
Now copy all the information from the original CTE download into the CTE detail tab of the reconciliation spreadsheet.  Next, copy all of the local class codes you from the local classroom code tab you just created into cell A3 of the CTE analysis tab on the reconciliation spreadsheet
In the CTE analysis tab copy the formula from cell B3, to column S as far down as you need for the classes you have.  Go to cell Y3 and enter your state share index.  You now have detailed information on each class that was offered.  You have how many CTEs populated your SFPR, categories c1 through c5, in column F, your “open enrolled in” CTEs in column G, and your “other” CTEs in column H by class.  You can also see how much funding a class generated in column I as well as how many students were in the class in column I.  Column K through R shows how many students were in the different fund pattern codes educated elsewhere.  
Put your cursor in cell B3, click on view, freeze panes, and then click freeze panes.  You may also want to put subtotals at the bottom of selected columns.
Enter the FTEs from c1-c5 from the SFPR detail worksheet report to cells AD12 down to AD16 of the CTE analysis tab.  In column AE the difference between the CTE detail and the SFPR will show.  Next enter the open enrollment CTEs from the open enrollment report into cells Y23 – Y27 and the positive Other CTE adjustments from the Other report into cells Y32 through Y36.

  

In Seat
This tab will populate automatically once you have entered your IRN in the SFPR tab, cell B4.  This tab reflects the students being educated in your buildings.  It must not be confused with your funding enrollment.  It also shows special education FTEs by grade and funding category being educated in your buildings.
If you do not feel that the numbers on this tab reflect the numbers being reported to you by your building staff you can easily determine what the correct numbers are.  Open your FTE detail report and go to column I, LEA IRN.  Make sure you have a filter on.  Select the IRN of your District only.  Go to column B, Bldg IRN.  When you click on the drop-down box you will find the IRNs of only your school buildings.  Click on the building IRN you want to verify and make sure all others are de-selected.  You can now copy these students into another spreadsheet, sort them by grade, alphabetically.  Send this spreadsheet to your building principal and have them verify the students on the list.  
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49890MINERVA LOCAL SD    /STARK COUNTY AREA JV -------- JVSD 0.42 0.42 ($2,520.00)N

43497ALLIANCE CITY SD STARK CTA5 0.06 0.06 ($78.48)N/A
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IRN

DISTRICT COUNTY TYPE FTE FTE or RECEIVED JOINTURE

44065

GIRARD CITY S.D. TRUMBULL OTH2 1 1 ($5,900.00)N/A

44065 Total

1 1

44735

SALEM CITY S.D. COLUMBIANAOTH2 1 1 ($5,900.00)N/A

44735 Total

1 1

45161

YOUNGSTOWN CITY S.D. MAHONING SE22 1 1 ($5,900.00)N/A

45161 Total

1 1

45328

COLUMBIANA EX VIL S. COLUMBIANAOTHK 1 1 ($5,900.00)N/A

45328 Total

1 1

46433

CRESTVIEW LOCAL S.D. COLUMBIANAOTH2 2 2 ($11,800.00)N/A

46433 Total

2 2

48322

JACKSON-MILTON LOCAL MAHONING OTH2 1.31 1.31 ($7,729.00)N/A

48322 Total

1.31 1.31

48363

SOUTH RANGE LOCAL S. MAHONING OTH2 48.37 48.37($285,383.00)N/A

48363

SOUTH RANGE LOCAL S. MAHONING OTHK 3 3 ($17,700.00)N/A

48363 Total

51.37 51.37

48397

WESTERN RESERVE LOCA/MAHONING CO CAREER &-------- JVSD 2 0.4 ($2,360.00)Y

48397

WESTERN RESERVE LOCA/MAHONING CO CAREER &-------- JVSE 2 0.4 ($2,360.00)Y

48397

WESTERN RESERVE LOCA MAHONING OTH2 26 26($153,400.00)N/A

48397

WESTERN RESERVE LOCA MAHONING SE22 7 7 ($41,300.00)N/A

48397 Total

37 33.8

50252

WEATHERSFIELD LOCAL /TRUMBULL CAREER & TE-------- JVSE 0.59 0.59 ($3,481.00)N

50252

WEATHERSFIELD LOCAL TRUMBULL OTH2 4 4 ($23,600.00)N/A

50252 Total

4.59 4.59

Grand Total

100.27 97.07

48397

WESTERN RESERVE LOCA MAHONING CTA1 0.12 0.12 ($599.04)N/A

51631

TRUMBULL CAREER & TE TRUMBULL CTA4 0.43 0.43 ($630.38)N/A

48397

WESTERN RESERVE LOCA MAHONING CTA5 0.29 0.29 ($364.82)N/A
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IRN

DISTRICT COUNTY TYPE FTE FTE or RECEIVED JOINTURE

44065 Total

1.00         1.00      

44735 Total

1.00         1.00      

45161 Total

1.29         1.29      

48298 Total

8.00         8.00      

48322 Total

1.31         1.31      

48363 Total

50.57      49.61    

48397 Total

30.00      26.80    

Grand Total

93.17      89.01    
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IRN

DISTRICT COUNTYTYPEFTE FTE or RECEIVEDJOINTURE

48397

WESTERN RESERVE LOCA/MAHONING CO CAREER & -------- JVSD 2.00   0.40   ($2,360.00) Y

50252

WEATHERSFIELD LOCAL /TRUMBULL CAREER & TE -------- JVSE 0.59   0.59   ($3,481.00) N
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Column Description Explanation/Example

A RPT DEST IRN District receiving the report

I LEA IRN School or District the student is educated in

M FTE FUND PTTRN CODE RGJV, OPDD, COMM, etc

Q ADJSTD FTE Funded FTE .01 to 1.0

R

ADJSTD SPECED CAT FTE

Funded Special Ed Category

S LEGAL DIST OF RES IRN Where party responsible for tuition resides

Y STATE EQUIV GRADE LEVEL CODE KG, 01, 02, etc

AA SPECED CAT CODE Special Ed Funding Categories 1 to 6

AB ECON DISADV FLAG Y or N

AC LEP CODE L, M, N, S, Y

AD FTE INCL CODE Full, Part, None

AI LEA TYPE Regular, STEM, B&M COMM, E-School, CBDD


image11.emf
STOW-MUNROE FALLS C

SUMMIT SE SE32 2 $31,244.00

WOODRIDGE LOCAL S.D

SUMMIT SE SE32 1 $15,622.00

HUDSON CITY S.D.

SUMMIT SE SE32 1.58 $24,682.76

SPRINGFIELD LOCAL S

SUMMIT SE SE32 1 $15,622.00

MANCHESTER LOCAL S.

SUMMIT SE SE42 0.7 $13,188.70

MANCHESTER LOCAL S.

SUMMIT SE SE52 0.3 $7,017.00

BEREA CITY S.D.

CUYAHOGASE SE62 1 ($31,637.00)
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ADM

Opportunity 

Grant

ADM

Weighted 

Amount

2 x 6,000             + 2 x 9,622           = 31,244.00   

1 x 6,000             + 1 x 9,622           = 15,622.00   

1.58 x 6,000             + 1.58 x 9,622           = 24,682.76   

1 x 6,000             + 1 x 9,622           = 15,622.00   

0.7 x 6,000             + 0.7 x 12,841         = 13,188.70   

0.3 x 6,000             + 0.3 x 17,390         = 7,017.00      

-1 x 6,000             + -1 x 25,637         = (31,637.00)  
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IRN

Community School Student FTEGrant AssistanceLiteracyDisadvantagedLEPSEC CTE TransportTotal Transfer

236

Ohio Connections Academy 2.00              11,800.00 0 0 0 0 0 251.6 0 12,051.60

623

Summit Academy-Youngstown 1.00              5,900.00 0.00 0 14.05 0 3,180.06 0 0 9,094.11

14231

*Bio-Med Science Academy STEM S 4.00              23,600.00 0 0 0 0 0.00 0 0 23,600.00

133413

Electronic Classrm Of Tomorrow 3.93              23,187.00 0 0 0 026,681.00 239.02 0 50,107.02

142950

Ohio Virtual Academy 4.05              23,895.00 0 0 0 0 0.00 0 0 23,895.00

143396

Alternative Education Academy 2.00              11,800.00 0 0 0 0 2,080.78 0 0 13,880.78

148999

Mahoning Unlimited Classroom 2.07              12,213.00 0 0 0.00 0 1,648.92 0 0 13,861.92
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54

IRN Community School

March #2

55 236Ohio Connections Academy 2.00          

56 623Summit Academy-Youngstown 1.00          

56133413Electronic Classrm of Tomorrow 3.93          

58142950Ohio Virtual Academy 4.05          

59143398Alternative Education Academy 2.00          

60148999Mahoning Unlimited Classroom 2.07          

61

62 Community School Total 15.05       

63

64

65

STEM

66 14231*Bio-Med Science Academy STEM S 4.00          


image3.emf
IRN

DISTRICT COUNTY TYPE FTE FTE or RECEIVED JOINTURE

50112

BRISTOL LOCAL SD    /TRUMBULL CAREER & TE -------- JVSD 1 0.2 $1,180.00 Y

50187

LAKEVIEW LOCAL SD   /TRUMBULL CAREER & TE -------- JVSD 1 0.2 $1,180.00 Y

44495

NILES CITY S.D. TRUMBULL OTH2 0.91 0.91 ($5,369.00) N/A

44990

WARREN CITY S.D. TRUMBULL OTH2 2 2 $11,800.00 N/A

45864

GRAND VALLEY LOCAL S ASHTABULA OTH2 2.38 2.38 $14,042.00 N/A

45864

GRAND VALLEY LOCAL S ASHTABULA SE22 0.38 0.38 $2,242.00 N/A

45864

GRAND VALLEY LOCAL S ASHTABULA CTA1 0.35 0.35 ($1,747.20) N/A

45864

GRAND VALLEY LOCAL S ASHTABULA CTA5 0.12 0.12 ($150.96) N/A


